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Preface

This User Guide has been implemented by Boot & Work, S.L. working
under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operating, to
functions, and to the technical data of the signal modules, power supply modules and
interface modules.

Intended Audience
This User Guide is intended for the following audience:

e Persons in charge of introducing automation devices.
e Persons who design automation systems.

e Persons who install or connect automation devices.

e Persons who manage working automation installation.

& Warnings:

e Unused pins should not be connected. Ignoring the directive may damage the
controller.

e Improper use of this product may severely damage the controller.

e Refer to the controller’s User Guide regarding wiring considerations.

e Before using this product, it is the responsibility of the user to read the product’s User
Guide and all accompanying documentation.

e Maintenance must be performed by qualified personnel familiarized with the
construction, operation, and hazards involved with the control.

e Maintenance should be performed with the control out of operation and
disconnected from all sources of power.

e Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

e The Spartan Arduino Family PLCs are Open Type Controllers. It is required that you
install the Spartan Arduino PLC in a housing, cabinet, or electric control room. Entry to



the housing, cabinet, or electric control room should be limited to authorized
personnel. Failure to follow these installation requirements could result in severe
personal injury and/or property damage. Always follow these requirements when
Spartan Arduino family PLCs.

In case of installation or maintenance of the Spartan Arduino PLC please follow the
instructions marked in the Installation and Maintenance section.

Do not disconnect equipment when a flammable or combustible atmosphere is
present. Disconnection of equipment when a flammable or combustible atmosphere is
present may cause a fire or explosion which could result in death, serious injury and/or
property damage.

Avertissements:

Les broches non utilisées ne doivent pas étre connectées. Ignorer la directive peut
endommager le controleur.

Une utilisation incorrecte de ce produit peut endommager gravement le controleur.
Reportez-vous au Guide de I'utilisateur du controleur pour les considérations de
cablage.

Avant d’utiliser ce produit, il incombe a 'utilisateur de lire le Guide de I'utilisateur du
produit et la documentation qui I'accompagne.

La maintenance doit étre effectuée par personnel qualifié familiarisé avec la
fabrication, le fonctionnement et les dangers liés au controleur.

La maintenance doit étre effectuée avec I'équipement hors service et déconnectée de
toutes les sources d'alimentation.

Faites attention lors de |'entretien des composants sensibles a |'électricité statique.
Les recommandations du fabricant pour ces composants doivent étre suivies.

Les automates de la famille Spartan sont des contréleurs de type ouvert. Il est
nécessaire d'installer I'automate Spartan dans un boitier, une armoire ou une salle de
controle électrique. L'acces au boitier, a I'armoire ou a la salle de commande
électrique doit étre limité au personnel autorisé. Le non-respect de ces exigences
d'installation peut entrainer des blessures graves et/ou des dommages matériels
importants. Respectez toujours ces exigences lors de l'installation des automates de la
famille Spartan.

En cas d'installation ou de maintenance du Spartan, veuillez suivre les instructions
indiquées dans la section Installation et Maintenance.

Ne débranchez pas I'équipement en présence d'une atmospheére inflammable ou
combustible. La déconnexion de I'équipement en présence d'une atmosphere
inflammable ou combustible peut provoquer un incendie ou une explosion pouvant

entrainer la mort, des blessures graves et/ou des dommages matériels.



Application Considerations and Warranty

Read and Understand this Manual

Please read and understand this manual before using the product. Please consult your
comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED.
THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR
PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE
NOT RATED OR DESSIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY
WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESSIGNED
TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE
PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE
OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or
standards that apply to the combination of products in the customer’s application or use
of the product.

The following are some examples of applications for which particular attention must be
given. This is not intended to be an exhaustive list of all possible uses of the products,
nor is it intended to imply that the uses may be suitable for the products:

e Systems, machines, and equipment that could present a risk to life or property.

¢ Nuclear energy control systems, combustion systems, railroad systems,
aviation systems, medical equipment, amusement machines, vehicles, safety
equipment, and installation subject to separate industry or government
regulations.

e Outdoor use, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party
certification documents identifying ratings and limitations of use that apply to the
products. This information by itself is not sufficient for a complete determination of the
suitability of the products in combination with the system, machine, end product, or
other application or use.



Intended use or of Industrial Shields products

Consider the following:

Industrial Shields products should only be used for the cases of application foreseen in
the catalogue and the associated technical documentation. If third-party products and
components are used, they must have been recommended or approved by Industrial
Shields.

The correct and safe operation of the products requires that your transport, storage,
installation, assembly, operation and maintenance have been carried out in a correct It
must respect the permissible ambient conditions. You should also follow the indications
and warnings that appear in the associated documentation.

The product / system dealt with in this documentation should only be handled or
manipulated by qualified personnel for the task entrusted and observing what is
indicated in the documentation corresponding to it, particularly the safety instructions
and warnings included in it. Due to their training and experience, qualified personnel
are in a position to recognize risks resulting from the handling or manipulation of such
products / systems and to avoid possible hazards.

Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing
purposes, even when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in
determining suitability and does not constitute a warranty. It may represent the result of
INDUSTRIAL SHIELDS'’s test conditions, and the users most correlate it to actual
application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS
Warranty and Limitations of Liability.

Change in Specifications

Product specifications and accessories may be changed at any time based on
improvements and other reasons.

It is our practice to change model numbers when features are changed, or published
ratings or when significant construction changes are made. However, some
specifications of the products may be changed without any notice. When in doubt,
special numbers may be assigned to fix or stablish key specifications for your
application on your request. Please consult with your INDUSTRIAL SHIELDS
representative at any time to confirm actual specifications of purchased products.



Errors and Omissions

The information in this document has been carefully checked and is believed to be
accurate; however, no responsibility is assumed for clerical, typographical, or
proofreading errors, or omissions.

The control and drive components of an Industrial Shields PLC are approved for
industrial and commercial use in industrial line supplies. Their use in public line
supplies requires a different configuration and/or additional measures. These
components may only be operated in closed housings or in higher-level control
cabinets with protective covers that are closed, and when all of the protective devices
are used. These components may only be handled by qualified and trained technical
personnel who are knowledgeable and observe all of the safety information and
instructions on the components and in the associated technical user documentation.
When carrying out a risk assessment of a machine in accordance with the EU
Machinery Directive, the machine manufacturer must consider the following residual
risks associated with the control and drive components of a PDS.

1. Unintentional movements of driven machine components during commissioning,
operation, maintenance, and repairs caused by, for example: — Hardware defects
and/or software errors in the sensors, controllers, actuators, and connection technology
— Response times of the controller and drive — Operating and/or ambient conditions not
within the scope of the specification — Condensation / conductive contamination -
Parameterization, programming, cabling, and installation errors — Use of radio devices /
cellular phones in the immediate vicinity of the controller — External influences /
damage.

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by,
for example: — Component malfunctions — Software errors — Operating and/or
ambient conditions not within the scope of the specification — External
influences / damage.

3. Hazardous shock voltages caused by, for example: — Component malfunctions -
Influence of electrostatic charging — Induction of voltages in moving motors — Operating
and/or ambient conditions not within the scope of the specification - Condensation /
conductive contamination — External influences / damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose
a risk to people with a pacemaker, implants or metal replacement joints, etc. if they are
too close.

5. Release of environmental pollutants or emissions as a result of improper operation
of the system and/or failure to dispose of components safely and correctly.



Warranty and Limitations of Liability

Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in
materials and workmanship for a period of one year (or other period if specified) from
date of sale by Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY,
EXPRESSED OR IMPLIED, REGARDING MERCHANABILITY, NON-
INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE OF THE PRODUCTS.
ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE
HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE
REQUIREMENTS OF THEIR INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS
ALL OTHER WARRANTIES, EXPRESS OR IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT,
OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN
ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS
BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONISBLE FOR WARRANTY,
REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL
SHIELDS’S ANALYSIS CONFIRMS THAT THE PRODUCTS WERE PROPERLY
HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO
CONTAMINATION, ABUSE, MISUSE, OR INAPPROPIATE MODIFICATION OR
REPAIR.
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1. Spartan Arduino PLC 16RDA: General Features

Supply Yaltage

24 \cce

I/Os

SPARTAN ARUDINO PLC 16RDA

Fuse protection (2.5A)
Input Voltage 12 to 24Vdc Polarity protection
Input rated voltage 24 Vdc
Rated Power 30W
| Max. 1,5A
Size 100x45x115
Clock Speed 16MHz
32KB of which 4KB are used by
Flash Memory bootloader
SRAM 2.5KB
EEPROM 1KB

Communications

12C -- USB - RS485 (Half Duplex)

-- SPI -- TTL (by Software) RS485
TOTAL Input points 6
TOTAL Output points 6
0 to 10Vac
Input Impedance: 39K
Separated PCB ground
Rated Voltage: 10Vac
An/Dig Input 10bit
(0-10Vcce) 5 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation
Rated Voltage: 24 VVdc
* Interrupt isolated Input 5 t0 24vdc 5 to 24Vdc
I min: 2 to 12 mA | min: 3/6 mA
HS Galvanic Isolation Se arated PCB around
(24vce) Rated Voltage: 24Vdc P 9

Analog Output 8bit
(0-10Vcc)

0 to 10Vac
I max: 20 mA
Separated PCB ground
Rated Voltage: 10Vac

Digital Isolated Output

220V Vdc
Galvanic Isolation
Diode protected for Relay

Imax: 5A

8bit (24vce)

Diode Protected for Relay
Rated Voltage: 24Vdc

Relay _
5 to 24Vdc
I max: 70 mA
PWM Isolated Output Galvanic Isolation PWM lIsolated

Output 8bit (24vce)

Expandability

12C —RS485 - SPI-TTL

Reference

017001001200
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2. Technical Specifications

2.1.General Specifications:

Power supply

voltage DC power supply

12 to 24Vdc ===

Operating

voltage range DC power supply

11.4t0254Vdc ===

Power
consumption DC power supply 30VAC max.
External Power supply voltage | 24vdc ===
power supply
Power supply output 200 mA

capacity

Insulation resistance

20MQ min. at 500Vdc between the AC terminals and the protective ground
terminal.

Dielectric strength

2.300 VAC at 50/ 60 Hz for one minute with a leakage current of 10mA max.
Between all the external AC terminals and the protective earth terminal.

Shock resistance

80m/s? in the X, Y and Z direction 2 times each.

Ambient temperature (operating)

0°to 60°C

Ambient humidity (operating)

10% to 90% (no condensation)

Ambient environment (operating)

With no corrosive gas

Ambient temperature (storage) -20° to 60°C
Power supply holding time 2ms min.
Weight 350g max.

11




2.2.Performance Specification:

2.3.Symbology

Table that includes all the symbology that is used in the serigraph of the Spartan Arduino PLC 16RDA.

Svmbol Standard No. / Standard
y Standard Title Reference No. / Symbol Meaning
Symbol Title
IEC 60417 / . . .
EE——— ) . Indicates that the equipment is
- EE = Graphical symbols 5031/ Direct suitable for direct current only;
for use on Current . . .
) to identify relevant terminals
equipment
IEC 60417 / Indicates that the equipment is
Graphical symbols 5032 / Alternatin suitable for alternating current
N for use on C 9 only; to identify relevant
) urrent :
equipment terminals
IEC 60417 /
Graphical symbols To identify the control by
for use on 5130/ Pulse which a pulse is started.
) General
equipment
IEC 60417 / To identify an earth (ground)
Graphical symbols terminal in cases where
for use on 5017/ Earth, neither the symbol 5018 nor
. Ground : - .
equipment 5019 is explicily required.
IEC 60417 / . . .
Graphical symbols To identify the swﬂch by
means of which the signal
for use on 5115/ Slgnal lamp . .
) lamp(s) is (are) switched on or
equipment

off.

Arduino Board

ARDUINO LEONARDO

Control method

Stored program method

I/O control method

Combination of the cyclic scan and immediate refresh processing methods.

Programming language

Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform
composed of a programming language. “similar to the C”.
http://arduino.cc/en/Tutorial/HomePage

Microcontroller

ATmega32u4

Flash Memory

32KB of which 4KB are used by bootloader

Program capacity (SRAM) 2.5KB
EEPROM 1KB
Clock Speed 16MHz

12
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Medical Devices CE marking indicates that a
Directive CE Marking product complies with
93/42/EEC applicable European Union
regulations
Gra Iﬁicc)a|720(r)r<bols Indicates a potentially
Al 04348 / hazardous situation which, if
cquibment Warning symbol not avoided, could result in
quip death or serious injury
ISO 7000/
Graaglrclies})grrqbols 5036 / Dangerous To indicate hazards arising
equipment Voltage from dangerous voltages

3. Precautions

Read this manual before attempting to use the Spartan Arduino PLC 16RDA and follow its
descriptions for reference during operation.

3.1  Arduino Board

The Spartan Arduino PLC 16RDA PLCs include Arduino Leonardo Board as controller.

3.2 Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.3 General Precautions

The user must operate Spartan according to the performance specifications described in this
manual.

Before using Spartan Arduino PLC 16RDA under different conditions from what has been
specified in this manual or integrating Spartan Arduino PLC 16RDA to nuclear control systems,
railroad systems, aviation systems, vehicles, combustion systems, medical equipment,
amusement machines, safety equipment and other systems, machines, and equipment that may
have a serious influence on lives and property if used improperly, consult your INDUSTRIAL
SHIELDS representative. Ensure that the rating and performance characteristics of Spartan are
sufficient for the systems, machines, and equipment, and be sure to provide the systems,
machines, and equipment double safety mechanisms. This manual provides information for
programming and operating the Spartan.

13



4 Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C
language. They can also be programmed using directly C but it is much easier working with
Arduino IDE as it provides lots of libraries that helps in the programming.

Furthermore, Industrial Shields provides boards for programming the PLCs much easier.
Basically, it is no needed to define the pins and if that pins are inputs or outputs. Everything is
set up automatically if using the boards.

In order to install Industrial Shields boards, these are the steps that must be followed.

Requirements:
Arduino IDE 1.8.0 or above (better to have always the latest version).
Steps:

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.

Preferences X

Settings | Netwaork:

Shetchbool: location:

C:\Users\Albert\Documents\Arduing Browse
Editor language: English (English) ~ | (requires restart of Arduino)
Editor font size: 15

Interface scale: Automatic | 100 T %  (requires restart of Arduino)

Show verbose output during: [ compilation upload
Cnmpller warnings: None ~

[Joisplay line numbers

[Jenable code Folding

Verify code after upload

[Juse external editor

Checl: for updates on startup

Update sketch files to new extension on save (.pde -> .ino)

Save when ver fying or uploading

Additional Boards Manager URLs: | hittp://apps. industrialshiz|ds. com/main /arduina/boards/package_industrialshislds_inde: [0

More preferences can be edited directly in the file
C\users\Albert\AppDatal ocal\Arduino1S\preferences. txt
(edit only when Arduino is not running)

OK Cancel

2. In Additional Boards URLs write the following:

http://apps.industrialshields.com/main/arduino/boards/package industrialshields index.json

3. Press OK to save the changes.

14
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4. Goto: Tools -> Board: ... -> Boards Manager

@ sketch_mari6a | Arduin 180
le Edit Sketch Tools Help

Auto Format

Achive Sketch

Fix Encoding & Reload
Serial Monitor

Sertal Plotter

WFi101 Finmware Updater

Board: "M-Duino family”

Inchusirial Shaelcls: "M-Duino 58+

Port
Get Board Info

Programmer: “Ardhino as ISP’
Burn Bootioader

5. Search for industrialshields.

Boards Manager...
Arduino AVR Boards

Arduin Yiin

Ascluino/Genwino Una

Arduino Duemilanove or Diecimila
Arduine Hano

Arduino/Genno Mega of Mega 2560
Asdluing Mega ADK

Arduino Leonardo

Arduine Leonardo ETH

Archuing/ Genuano Micro

Arduing Esplora

Ardino Mini

Arduino Ethernet

Arduino Fio

Ascluino BT

LilyPad Arduno US8

LilyPad Archino

Archuing Pro of Pro Mim

Aschuin NG or older

Arduin Robot Control

Arduino Robot Motor

Arduino Gemma

Adalruit Circuit Payground

Arduino Yun Mini
Arduine Incustrial 101
Linino One
Arduine Uno WiFi
Industaial Shields b
Ardbox family

# M-Duino family

€ Boards Manager

Type All ~ | lindustrialshields

industrialshields

Boards included in this package:
ARDBOX family, M-Duino family.
Online help

More info

~ | Install

Close

15



6. Click install (selecting the latest version).

Following these steps you will be able to use now the Industrial Shields Boards:

© sketch mar31h Arduino 1819

Archivo Editar Programa Herramientas A

- o X
Au ato CteT 5]
Archivo de programa. =

=
Reparar codificacion & Recargar.

Administrar Bibliotecas.

// put yg Moniorsere | once:
Serial Plotter

} WIF101 / WIFININA Firmware Updater
Placa: “Spartan family” 3
Modet: “Spartan 16RDA >

void loop()

>
// put yc Obtén informacion de fa placa Industrial Shields boards 3 Ardbox family
>

= Industrial Shields ESP32 Ardbox DALI family
Programador >
Industrial Shiel aAVR Boards > Ardbox GPRS fami
i Giakraoe industrial Shields megaAVR Boards Ardbox GPRS family
} Intel Curie (32-bit) Boards > Ardbox WiFi/BT family

Ardbox LoRa family

© sketch_mar31b Arduing 1.8.19 - o ®

Archiva Editar Programa Herramientas Ayuda
Auto Formato ct+T
Aschiva de programa

“ B Reparar codificacién & Recargar.
void setup( adminsuar sibiotecas Ctrl+Mayas
// put yc Monitor Serie CulsMayisM | oncas

Serial Plotter CrlsMayds+L

} WIFI101 / WiFININA Firmnware Updater

Modet: “Spartan 16RDA” 2 s
void loop()
// pUt yC Programadar Spartan 21 y
} Quemar Bootloader

Also, there are some examples of programming in File -> Examples -> Spartan Arduino Family.

Furthermore, there are some extra libraries that can be found in Industrial Shields GitHub.

https://github.com/IndustrialShields/

16
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How to connect PLC Arduino to PC

Connect USB port from PLC to PC.

NOTE:
Spartan Family uses micro USB cable.

Open Arduino IDE interface:
Select Industrial Shields boards -> Spartan Family
Select correct port.

@ sketch_mar16a | Arduino 180 - o x
File Edit Sketch Tools Help

Auto Format colsT
Archive Sketch
Fix Encoding & Reload

| Serial Moritor ColaShifeaM
Serial Plotter ColsShitesd

WIF101 Firmware Updater

Boardt “Ardbas family
Inchustrial Shields: “Ardbox Analag”

Senal ports
COM13 (Arching Leonarddo)

17



6 How to connect PLC to power supply

- Spartan Arduino PLC is 12-24Vdc supplied. IMPORTANT: The polarity IS NOT
REVERSAL!

- Make sure that the live and GND connector of the power supply match the PLC.

- Make sure that the power supply mains output is not higher than 24Vdc.

- Suggested power suppliers

Compact DIN rail power supply. Assembled on 35mm
. \ !
DIN Rail: m |
-12Vdc / 24Vdc S
-2.5A
-30W

Industrial Shields power supplies provide parallel
operation, overvoltage protection, and overcurrent

protection. There is a LED inductor for power status,
the power supply is certified according to UL.

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types
of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC 61010-
1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-1.

WARINING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of the
equipment must be separated from the dangerous voltage cables.

18



7 Spartan Arduino PLC 16RDA I/0 pinout:

7.1  Zone Connections LEFT ZONE
ON OFF.
NC
LEFT ZONE %[N
RS PING-SCL
o o
=) - 10.0 FINS-SDA Switch config*
-E E o 5 N (see section 8 for Communications
< c 2 k3 *IFF configuration. Enabling Communications
- O = c :
sC 'E T [N disables some 1/0s)
s 9 < *OFF
(?)- o DN—_IIF
MISO x
MOSI y E
MISO 14 SPI-MISO SCK -0
MOSI 16 SPI-MOSI RESET F
SCK 15 SPI-CLOCK Vo g I -
RESET ) SPI-RESET EN]] c = Communications pins
5Vdc - 5V Output =
GND - GND ';% z
NC - Not Connected . =
NC - Not Connected PINZ-SDA | 5
SDL-PIN2 2 12C/SPI SS PIN3-SCL_J# 2
SDA-PIN3 8 12C/SPI SS =
R1 10 Relay 1 out E
R2 9 Relay 2 out Rl
R3 6 Relay 3 out

GNDCOM GND Relay Outputs

D

GND
Vd

Power supply connectors
(24vdc - GND)

PARS-2l
dIN0d

24VCOM - Power Supply @ RD
R3
C




RIGHT ZONE

RIGHT ZONE -
o o A+ RS-485 pins
£28
ERs £ NC
T o o g NC
S c kel
< c e 3
g3 3 5 e
i S
°o | E T Re /|
o [
&o Relay Outputs
B- - RS485 *
A+ - RS485 RS l.:
NC - Not Connected S—
NC - Not Connected —
R4 5 Relay 4 Out NC
R5 3 Relay 5 Out NC
NC - Not Connected —o(Ge— | 107
NC - Not Connected L oCe— | 106
10.7 21 Analog / Digital Input G- | NC
10.6 20 Analog / Digital Input 5 0 NC Digital/Analog Inputs pins
NC - Not Connected “
NC - Not Connected 5 —0e 10.3
10.3 8 Digital Input 5 o 102
10.2 4 Digital Input ¢ Lo~e [0
10.1 12 Digital Input & o | 100 ¥
10.0 2 Digital Input / Interrupt = L —cn
R6 7 Relay 6 Out S ,_
NC = Not Connected -
NC - Not Connected = R6 Relay Output
g -
e —_—
O —= =
=4
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Cul T
255 —
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L85 N
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(see section 8 for communications

configuration)
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O [a¥]
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8 Switch configuration

8.1

LEFT ZONE.

General Switches Configurations

Communications and inputs/outputs can not work simultaneously.

LEFT ZONE
SWITCH ON OFF
NC
ON Selected
R5 R5 Pin3-SCL
10.0/Pin2 - SCL 10.0 Pin2-SDA
ON Selected
OFF Selected
ON Selected
OFF Selected

OFF ON
NC
ON
R5/Pin3-SCL
10.0/Pin2-SDA
ON
OFF
ON
OFF
OFF ON

1. NC-Not Connected

2. Always at ON position.

3. R5-SCL - Choosing between SCL (12C) and R5. If the switch is OFF, the R5 will be enabled and the
SCL will be disabled. If the switch is ON, SCL will be now enabled.

4. 10.0/Pin2-SDA - Choosing between SDA (12C) and 10.0. If the switch is OFF, the 10.0 will be enabled

and the SDA will be disabled. If the switch is ON, SDA will be now enabled.

1. Always at ON position.

2. Always at OFF position.

3. Always at ON position.

4. Always at OFF position.

Note: Don’t change the switch position

OFF

ON

O

O

ON

ON

FF

FF

TOP ZONE

4. Always in ON position.

3. Always in OFF position.

2. Always in ON position.

1. Always in OFF position.
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8.2 RS- 485 Switch configuration

TOP ZONE
MODE

RS-485 TOP ZONE: In order to enable the RS-485 protocol the TOP ZONE
must be configured as it is shown in the table.

ON

OFF

ON

OFF

MODE

ON

ON

OFF

ON

OFF

RS-485 LEFT ZONE: In order to enable the RS-485 communication protocol
it is necessary that the switches of the left zone are configured as it is

showed in the table.

The ones marked with “-“ mean that they don’t affect the RS-485

communication protocol.

* To enable the RS-485 communication it is needed to configure also the jumpers, see Section 9

8.3  12C Switch configuration

LEFT ZONE
MODE

TOP ZONE
MODE

ON

ON

To enable 12C configuration the switches SCL/R5 & SDA/10.0 must be set to ON. As they are in

ON mode R5 & 10.0 are disabled.

The switches marked as “ - “ don’t interfere with the 12C communication protocol.
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9 Spartan - Arduino 1/0s 5V pins

The Spartan has some of the Leonardo board pins available. These pins can be programmed
according to Arduino features such as I/Os operating at 5V or any additional features present
in the pins (for example I2C communication in pins SCL and SDA). As these pins are directly
connected to the Arduino Leonardo board they are not as well protect as the normal inputs.
These pins are mainly meant to be used as prototyping.

Spartan terminal Arduino pin
SCL-Pin3 3
SDA-Pin 2 2

MISO 14
SCK 15
MOSI 16

*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than 5V.
These terminals provide direct access to the Leonardo board.

Apart from the switch configuration there are some special conditions depending on these 5V.
Now it is going to be shown the considerations to operate with these pins.

9.1 I2C pins - SDA/SCL

The 12C protocol is meant to work in a pull-up configuration. The I12C pins in the Arduino
Leonardo are not pull-up, so in order to work with the I2C an external pull-up resistor is
required. If it is meant to work as a GPIO at 5V, the switches must be set as 12C, (section 8).

These pins are not stablished with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not, it
must be stablished an external pull-up or pull-down circuit in order to correctly work with
these pins.

9.2  Pin2/Pin3

These pins are only referred to the inputs 10.5/10.6. If the switch configuration is in OFF
position the pins Pin 2/Pin 3 will be available.

These pins are not stablished with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be stablished an external pull-up or pull-down circuit in order to correctly work with
these pins.
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10 1/0 technical details

Digital Output Waveform

[N o —1
v

DIGITALOUT

DIGITAL OUT
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PWM Waveform

PFWM OUTPOLUT

—Sewrm  —e———
ARDUIND PWHM OUT

——

v

ANALDG OUT
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Analog/Digital Input Turn-on
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Ref. 017001001300

11 Typical Connections

Ferrite KIT,

Y

oz,

SHIELDED CABLE %

SHIELDED CABLE

snarav

O0-10V

£,

n

o

\

SHIELDED CABLE 4 Downboad e MOUSNO LAYOUT: \

errite KITA

.7

Rev.2: 31-03-2023

27



Ref. 017001001300 Rev.2: 31-03-2023
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SHIELDED CABLE z-’ o wene bttt com \-\

SHIELDED CABLE

sn2pav

GND
ALWAYS
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Ferrite KI
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Ref. 017001001300

SHIELDED CABLE

Ferrite KIT#

Rev.2: 31-03-2023

2124V

Ferrite KIT

-

SHIELDED CABLE

SHIELDED CﬂBﬁ’ﬂ—L—\‘ AR LR

* See the switch
configutarion (ON)
51224V
GND A
\J ALwavs
JUl CONNECTED
® SHIELDED CABLE
VOUT = Q / Vide
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QN * See the switch

o7 T 08 configutarion (OFF)
08080 o 0 Mw)
0 L

= SHIELDED CABLE

Ferrite KITA o

SHIELDED CABLE Download the MDUINO LAYOUT:
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12 Connector details

The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 THT — 1963502
from Phoenix contact. MC0,5/10-G-2,5THT+

For I/O and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix
contact. FK-MC 0,5/10-ST-2,5

Connection details:

Article reference MC 0,5/10-G-2,5 THT
Height 8,1mm
Pitch 2,5mm
Dimension 22,5mm
Pin dimensions 0,8x0,8mm
Pin spacing 2,50mm
Article reference FK-MC 0,5/10-ST-2,5
Rigid conduit section min. 0,14 mm?
Rigid conduit section max. 0,5 mm?
Flexible conduit section min. 0,14 mm?
Flexible conduit section max. 0,5 mm?
Conduit section AWG/kcmil min. 26
Conduit section AWG/kcmil max. 20
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13 Spartan Family Dimensions:

45mm width

&

114

DIN rail mounting:

Profilato o coppello TH 35-7,5
Top hot rail TH 35-7,5

Prfilato o coppello TH 35-15
Top hat rail TH 3515

155
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14 Installation and Maintenance

Notes for installation:

- Theinstallation position should be free from the following: dust or oil smoke,
conductive dust, corrosive or flammable gas, high temperature, condensation, and
rain.

- Besides, vibration and impact also affect the PLC normal operation and shorten its
lifespan; electric shock, fire or misact also damages the product. During drilling or
wiring, prevent the metal particles or wire segments from falling into the PLC casing,
which may cause fire, fault or misact.

- After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.

- Do notonline connect, plug or unplug cables, which is apt to cause electric shock or
damage the circuit. Installation and wire connection must be firm and reliable. Poor
connection could cause misact.

- Use shielded twisted pair for the I/O of high frequency signal and analog signal to
improve system IMS.

The installation environment should be free from dust, oil smoke, conductive particle,
corrosive or flammable gases, high temperature, condensation, and rain.

Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan.
It is recommended to install the PLC, together with the matching switches and contactors,
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high
ambient temperature or heat generating equipment nearby, install forced convection
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring,
prevent the metal particles or wire segments from falling into the PLC casing, which may
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent
blocking, which may cause bad ventilation, or even fire, faults or misact.

The only way to disconnect the equipment from the electrical network is by removing the
connectors that feed the equipment. Once installed in the electrical cabinet it is very
important to ensure the power connectors for proper operation.

Separate the Spartan Arduino PLC 16 RDA heat, high voltaje and eletrical noise:

Always separate the devices that generate high voltage and high electrical noise from the
Spartan Arduino PLC 16RDA. When configuring the layout of Spartan Arduino PLC 16RDA
inside your panel, consider the heat-generating devices and locate the electronic-type
devices in the cooler areas of your cabinet. Reducing the exposure to a high-temperature
environment will extend the operating life of any electronic device. Consider also the
routing of the wiring for the devices in the electric cabinet. Avoid placing low-voltage
signal wires and communications cables in the same tray with AC power wiring and
highenergy, rapidly-switched DC wiring.
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Provide adequate clearance for cooling and wiring Spartan Arduino PLC 16RDA. Is designed for
natural convection cooling. For proper cooling, you must provide a clearance of at least 25 cm
above and below the devices. Also, allow at least 25 cm of depth between the front of the
modules and the inside of the enclosure.

Notes for maintenance:

A well-planned and executed maintenance program is essential to the satisfactory operation of
solid-state electrical equipment. The kind and frequency of the maintenance operation will
vary with the kind and complexity of the equipment as well as with the nature of the operating
conditions. Maintenance recommendations of the manufacturer or appropriate product
standards should be followed.

The following factors should be considered when formulating a maintenance program:

- Maintenance must be performed by qualified personnel familiar with the construction,
operation, and hazards involved with the control.

- Maintenance should be performed with the control out of operation and
disconnected from all sources of power.

- Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

- Ventilation passages should be kept open. If the equipment depends upon auxiliary
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when
necessary) should be made of these systems.

- The means employed for grounding or insulating the equipment from ground should
be checked to assure its integrity.

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks,
should be removed according to the manufacturer's instructions, if provided;
otherwise, the manufacturer should be consulted. Care must be taken to avoid
damaging any delicate components and to avoid displacing dust, dirt, or debris in a
way that permits it to enter or settle into parts of the control equipment.

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and
dirt should be removed from the top of the enclosures before opening doors or
removing covers.

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g.,
polychlorinated biphenyls (PCBs) found in some liquidfilled capacitors) must be
disposed of as described in Federal regulations.

Safety rules for maintenance personnel

Consider the following steps to follow. A false manoeuvre could be the cause of an
accident or material damage.

Do not disassemble or modify the modules. This could lead to breakdowns or
malfunctions and could lead to injuries or fire.

- All types of radio communication devices, including mobile phones and personal
handy-phone systems (PHS), must be kept more than 25cm away from the PLC in all
directions. Failure to observe this precaution exposes malfunctions caused by excess of
temperature.
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- Disconnect the external power supply of the system (on all phases) before connecting
or disconnecting a module. Failure to observe this precaution may cause faults or
malfunctions of the module.

- Tighten the screws of the terminal ports and the screws of the connectors within the
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires
and cause malfunctions. Excessive tightening can damage the screws and / or the
module, with the risk of falling, short circuits and malfunctions.

- Before handling a module, dispose of the electrostatic charge accumulated by the
human body by touching a suitable conductive object. Failure to observe this
precaution may cause faults or malfunctions of the module.

Repair note:

If the equipment is suitable to be repaired, it must be verified that the equipment
remains in a safe state after repair.
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15 Revision Table

Rev.2: 31-03-2023

Revision Number Date Changes
0 23/ 06/ 2020 It was first implemented
1 09/04 /2021 Changes on the serigraphy
2 31/03/2023 Change on Section 7.
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About Industrial Shields:

Direction: Cami del Grau, 25

Zip/Postal Code: 08272

City: Sant Fruitds de Bages (Barcelona)

Country: Spain

Telephone: (+34) 938 760 191 / (+34) 644 92 79 00

Mail: industrialshields@industrialshields.com
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